Opens the folder one level above the active folder.



Shows the Favorites folder in the Look in box. The Favorites folder contains shortcuts to files and folders you
use often.



Creates a shortcut to the selected file or folder, and then adds the shortcut to the Favorites folder. The original file
or folder doesn't move.



Shows the names of the files in large icon format.



Shows additional information about the documents, such as the file size and the date last saved.



Shows properties for the selected document, such as the title and author.



Shows a preview of the selected document without opening it.



Lists the commands you can use to open a document as read-only or as a copy, print a document, show or edit
document properties, sort documents within folders, search subfolders, group files by folder, connect to a
network drive, add or modify FTP connections, and select an existing saved search.



Create a folder.



Opens the Search page of your Internet browser.






Click the color you want, or enter the values for the color in the Hue, Sat, Lum, Red, Green, and Blue boxes.
You can drag the slider to adjust the luminosity of the currently selected color.



Hue is the color itself. Enter a number from 0 to 255 in the Hue box, or drag the cross-hair horizontally in the
Color box.



Saturation is the intensity of the color. The higher the number, the more intense the color. Enter a number from 0
to 255 in the Sat box, or drag the cross-hair vertically in the Color box.



Luminance is the brightness of the color, or the amount of black or white added to the color. The larger the
number, the lighter the color. Enter a number from 0 to 255 in the Lum box, or drag the slider on the vertical color
bar.



Enter a number from 0 to 255 to adjust the amount of red in the color. The larger the number, the more red the
color contains.



Enter a number from 0 to 255 to adjust the amount of green in the color. The larger the number, the more green
the color contains.



Enter a number from 0 to 255 to adjust the amount of blue in the color. The larger the number, the more blue the
color contains.



Click the color you want, or click the Custom tab and mix your own color.



Makes the selected color partially transparent. Clear this check box to make the selected color completely
opaque. This effect of this option is not displayed in the New and Current sample box.



The New color is the one you selected in this dialog box — click OK to apply the new color to the selected object.
The Current color is the existing color of the object — click Cancel to retain the current color.






Shows the active directory.



Type a name for the new folder.






Displays the search criteria you specify.



Searches for variations of a word. For example, a search defined as "Contents includes write" finds all files that
contain the text write, writes, wrote, or written. This applies to all text property criteria, but not to the File name
property.



Searches for the exact combination of uppercase and lowercase letters as in your search criteria. This applies to
all text property criteria, but not to the File name property.



Removes the selected search criteria in the Find files that match these criteria box.



Restores the default search criteria.



Defines the search so that files found must meet all the criteria listed. For example, a search defined as
"Comments includes Microsoft AND Comments includes Office" finds all the files that contain both the word
Microsoft and the word Office in the Comments property.



Enter the file property you want to search for.



Click the condition you want to set for the property selected in the Property box.



Type a value for the property and condition you've specified. For example, to find all the files that contain the
word Microsoft in the Comments field, click Comments in the Property box, click Includes in the Condition
box, and type Microsoft in the Value box.



Adds the search criteria you've specified to the list of search criteria in the Find files that match these criteria
box.



Click the drive or folder you want to search.



Searches all subfolders of the selected folder.



Displays all files that match the criteria you've specified.



Saves the list of search criteria you've specified in the Open and Advanced Find dialog boxes. Save the search
criteria you use regularly to search for files quickly.



Displays saved searches that you can open, rename, or delete.



Displays the search criteria you specify.



Defines additional criteria you can use.



Defines the search so that files found must meet either criteria listed. For example, a search defined as
"Comments includes Microsoft OR Comments includes Office" finds all the files that contain either the word
Microsoft or the word Office in the Comments property.






Type the address of an FTP site, or click an address in the FTP sites box.



Select whether to log on with your user name or as an anonymous user.



Enter your user name.



Log on to an FTP site that allows log on by anonymous users.



Log on to an FTP site that your password gives you user privileges for.



Removes the selected FTP address from the FTP sites box.



Associates the FTP address with the logon and password information you specify for this address, and then
shows this information as the FTP address in the FTP sites box.



Shows the FTP sites you added. The logon and password information you specified when you added the
address to the FTP sites box is associated with the FTP address.



Type your user password for the FTP site.



To change an FTP address or the logon and password information associated with it, click the address in the
FTP sites box, and then click Modify.






Name of the FTP site.






Sites list map to 67165
FileName: DLGFTPS.DES
Caption:

Control: LIST_BOX

Number: 1162433 ( 0x11BCC1)



Add button map to 67164
FileName: DLGFTPS.DES
Caption: Add...

Control: PUSH_BUTTON
Number: 1227969 ( 0x12BCC1 )



Remove button map to 67163
FileName: DLGFTPS.DES

Caption: Remove

Control: PUSH_BUTTON

Number: 1293505 ( 0x13BCC1 )






Shows the active directory.



Type a name for the folder.






Click the drive or folder that contains the file you want. The contents of the drive or folder you select appear
below in the folder list.



Displays the files and folders in the drive or folder selected in the Look in box.



Opens the selected file or folder.



Displays additional properties you can add to your search criteria, and saves, renames, or deletes searches.



Select an option below to select criteria for finding files.



Enter the name of the file you want to find. For more information, click [,



To display the type of file you want to open, click the file type you want.



Enter the text you want to find. To find phrases, enclose text in quotation marks (" "). For example, to find only
files that contain the phrase modern dance, type "modern dance".



Click the time period when the files you want to find were last changed.



Displays the files that match the search criteria you specified to the left. During the search, the button name
changes to Stop. To cancel the search, click Stop.



Clears the specified search criteria.



Status of search.



Creates a link to the selected file rather than embedding it.



Saves the picture with the document. To decrease the size of your file, clear this check box.



Places the object in the drawing layer, where you can position it in front of or behind text and other objects by
using commands on the Draw menu. Clear this check box to place the object inline, in the current paragraph,
where it behaves like regular text.



Inserts the file as text in the body of the item. Use this option for messages you send to the Internet.



Specifies options for inserting files into the body of items.



Type the bookmark name or range of Microsoft Excel cells you want to insert, for example, B6:D18. You can also
enter a named range.



Inserts file as an attachment into the body of items.



Inserts a short cut to the file into the body of items. Use this option if the file you want to insert is large.



Properties of the file.






Names of the searches you've saved.



Opens the selected search.



Click to enter a new name for the selected saved search.



Removes the selected search.






Type the password for this file. You can open a password-protected file only if you supply the correct password.






Click the drive or folder that you want to save the file in. The contents of the drive or folder you select appear
below in the folder list.



Properties of the selected file.



Displays the files and folders in the drive or folder selected in the Save in box.



Saves the file.



Saves a version of the document with the comments you specify.



Type a name for the file.



To save the active document in another file format, click the file format you want.



Stores the TrueType fonts used to create this file along with the file. Others who open the file will be able to view
and print it with the fonts used to create it, even if those fonts aren't installed on their computer.



Click the file attribute you want to sort the files by.



Sorts files starting from the beginning of the alphabet, the lowest number, or the earliest date.



Sorts files starting from the end of the alphabet, the highest number, or the latest date.






Type a name for the search.






adjustment handle

A diamond-shaped handle used to adjust the appearance (not the size) of most AutoShapes. For example — you
can adjust a rounded rectangle to be more or less rounded, or you can adjust the arms of a cross to be thicker or
thinner.

Adjustment

Handle

[n] [n]

&



attribute

An object or text feature you can manipulate by using drawing tools and menu commands. Object attributes
include line style, fill, shadow, color, and shape. Text attributes include font, style, color, size, and so on.



grid

An invisible matrix used to align objects automatically. If the grid is on as you draw or move objects, their
corners align on the nearest intersection of the grid.



group
Two or more objects you treat as a single object. Groups can be composed of multiple sets of groups.



multiple selection

When two or more objects are selected. To select multiple objects, hold down SHIFT and click each object, or
drag a selection rectangle around the objects. When you flip, rotate, and resize a multiple selection, all objects in
the selection react independently.



picture

There are two kinds of pictures in this program: those you can ungroup and convert to objects (such as
metafiles), and those you can't (such as bitmaps). After you ungroup a picture, you can manipulate it with the
drawing tools. When you select a picture, the Picture toolbar appears with tools you can use to change the
attributes of a picture — for example, you can crop it or adjust its brightness.



sizing handle

A square handle that appears at each corner and along the sides of the rectangle that surrounds a selected
object. You drag a sizing handle to resize an object.



vertex

The highest point of a curve, the point where a curve ends, or the point where two line segments meet in a
polygon or freeform.



AutoShape

A group of ready-made shapes that include such basic shapes as rectangles and circles, plus a variety of lines
and connectors, block arrows, flowchart symbols, stars and banners, and callouts.

To insert an AutoShape, click AutoShape on the Drawing toolbar. To attach text to an AutoShape — except to a
line, connector, or freeform — click the shape and start typing. The text becomes part of the AutoShape.



bitmap

A picture made from a series of small dots that form shapes and lines. Bitmaps are created with paint programs
such as Microsoft Paint, or by scanning an image. Bitmaps can't be converted to drawing objects, although they
can be scaled, cropped, and recolored by using the tools on the Picture toolbar.



freeform

Any shape you draw by using the Curve, Freeform, and Scribble buttons (AutoShapes menu, Lines
category) — a puffy cloud, mountains, a lightning bolt, your name in cursive, and so on. Freeforms can include

straight lines and freehand curves. They can be drawn opened or closed and can be edited by using the drawing
tools.



crop

To trim vertical or horizontal edges of a picture by using the cropping tool on the Picture toolbar. After you crop a
picture, you can always uncrop it. Photos are often cropped to focus attention on a particular area of a picture.



selection rectangle

The box formed by sizing handles after you select an object.






Shows Help topics from the Office Assistant based on your actions before you ask for Help. Clear this check box
if you do not want Help topics to appear unless you ask for Help.



Moves the Office Assistant out of the way of elements on screen, such as dialog boxes. Automatically shrinks the
Assistant if it is not used within 5 minutes.



Turns on sounds for the Office Assistant. To turn off the sounds made by the Assistant, clear the Make sounds
check box.



Searches for both programming and product Help topics while you work with Visual Basic for Applications in your
program.



Shows tips for features you may not know and suggestions on how to better use features you know.



Shows tips about how to use the mouse to get your work done quickly.



Shows the shortcut keys you can use to get your work done quickly.



Shows only tips that are important, such as those that alert you to time-saving features.



Shows a Tip of the Day when an Office program starts as an easy way to get familiar with features.



Resets the tips so that tips you have already seen can appear again.



Shows messages from the Office Assistant.



Shows the Office Assistant when you press F1 in any Office program. Clear the Respond to F1 key check box if
you want Help to appear instead of the Assistant when you press F1. This option does not affect areas where the
Assistant is not used, such as some of the properties sheets in Microsoft Access.



Provides Help from the Office Assistant for most wizards in Microsoft Office.



Details about the Office Assistant.



Each Office Assistant has a unique name.



View another Office Assistant.



Preview the Office Assistant.



Example of an Office Assistant message.



Click the Next or Back button to view another Office Assistant.



Select the options you want. For help on a specific option, click the help button and click directly on the option.






Search criteria you can use in the File name box

In the File name box in the Open dialog box (File menu), you can do any of the following to locate your file:

Type Example

Partial file names Type region to find all files with names
that include "region."

File name Type *.txt to find text files.

extensions

Wildcard characters To find only file names that end with

"region", type *region; or type gr?y to
find instances of both "gray" and "grey"
in file names. Use an asterisk (*) to
match any number of characters, or
use a question mark (?) to match any
single character.

The full path Type c:\House finances\Property
taxes in 1995. When you include a
drive letter, share, or folder, the
program automatically updates the
location in the Look in box, displays
only the name of the file in the File
name box, and then opens the file.

Multiple paths Type c:\House finances;c:\My work
documents. Separate each path with
a semicolon.

Internet location To log on to a server on the Internet or

on your company's intranet, type the
URL (FTP and HTTP only), for
example, ftp://ftp.microsoft.com or
http://www.microsoft.com.

Tip To reuse a recent entry, you can click its file name in the File name box.




Click Select Picture to use a picture as the fill for the selected object. The picture stretches to completely fill the
object.



Displays the name of the selected picture.



Click the way you want the picture to fill the selected chart elements. Stretch resizes a single instance of the
picture so it completely fills the selected chart elements. Stack fills the selected chart elements with horizontally
and vertically tiled repetitions of the original-sized picture. Stack and Scale to resizes the picture, so the number
of repetitions you enter in the Units/Picture box fills the selected chart elements vertically. A smaller number in
the Units/Picture box means more repetitions of the picture, which may increase the amount of memory used
and the time it takes to draw the fill on the screen.



Select which faces of the selected chart elements you want to fill with the picture. If you clear a check box (or
later click Clear Formats on the Edit menu), the face retains the last-applied color formatting. The name of each
face is assigned when you initially insert the picture and does not change if you later rotate the object — for
example, the Front face is called Front even if you rotate it to the side.



Click the color settings you want for the gradient fill. For more information about each color setting, click El
and then click the option.



Fills the selected object with a single color that fades gradually to black or white. Click the color you want in the
Color 1 box, and then drag the Dark/Light slider to adjust the intensity of the color.



Fills the selected object with one color that fades gradually to another color. Click the colors you want in the
Color 1 and Color 2 boxes.



Fills the selected object from a set of specially created gradient fills. Click the name of the color set you want in
the Preset colors box.



Click the color you want. If you clicked One Color, this color will fade gradually to black or white. If you clicked
Two colors, this color will fade into the color you click in the Color 2 box.



Click the name of the built-in color set you want to use for a gradient (shaded) fill.



Click the color you want for the second color of a two-color gradient (shaded) fill.



Drag the slider toward Dark to make the color fade gradually to black. Drag the slider toward Light to make the
color fade gradually to white.



Click the gradient (shaded) fill style you want, and then click a variation of the style under Variants.



First, click the fill style you want under Shading Styles, then click a variation of the style under Variants.



Click the special texture you want to use as the fill for the selected object. The name of the texture you click
appears in the description box below. To add a texture to the list, click Other Texture.



Opens a different file that you can use as a textured fill. You can use a Windows Bitmap (a .bmp or .dib file) or
Windows Metafile ( a .wmf or .emf file) as a textured fill. You can also use any graphics file for which you have an
import filter installed; for example, you can use a JPEG file (.jpg) if the JPEG import filter is installed on your
computer.



Click the fill pattern you want. To change the pattern colors, click new colors in the Foreground and
Background boxes.



Describes the pattern, texture, or picture you clicked above.



Click the foreground color you want for the pattern.



Click the background color you want for the pattern.



Shows what the selected options will look like if you click OK.






Click the line color you want for the selected AutoShape. Click Patterned Lines if you want to add a pattern to
the line.



Click the line style you want. If you want a thicker or thinner line, click a line style, and then change the Weight
setting.



Displays the weight of the currently selected Style. To make that line thinner or thicker, enter a new value in the
Weight box.



Click a dashed-line style, or click the solid line if you don't want a dashed line.



Click the connector style you want for the selected object. Connectors are lines that connect objects and remain
attached even if you rearrange the objects. This option is available only when the selected object is a connector
line.



Click the arrow style you want for the beginning of the selected line. If you don't want an arrow on this end of the
selected line, click the straight line.



Click the arrow style you want for the end of the selected line. If you don't want an arrow on this end of the
selected line, click the straight line.



Click the arrow size you want for the beginning of the selected line. To remove the arrow, click the straight line in
the Begin style box.



Click the arrow size you want for the end of the selected line. To remove the arrow, click the straight line in the
End style box.



Click the fill color you want for the selected AutoShape. Click Fill Effects if you want to use a pattern, gradient,
texture, or picture fill.



Uses the currently selected options as the default settings for all new AutoShapes you insert in your
presentations.



Makes the selected solid-color fill partially transparent. Clear this check box to make the selected fill completely
opaque. This check box is unavailable if the selected object contains a gradient, texture, pattern, or picture fill
effect.



Moves the selected object up or down on the page if you move the paragraph the object is anchored to. When
you select this check box, Word changes Horizontal from to Column and changes Vertical from to Paragraph.
Word clears this check box if you change the Vertical from or Horizontal from settings.



Keeps the selected object on the same page as the text it is anchored to. The object can move with its anchor,
but it always stays on the same page as the anchor.



Enter the height you want for the selected object. The Height and Width settings are always the dimensions of
an unrotated object. Alternatively, you can adjust the height as a percentage of the original size by entering a
percentage in the Height box under Scale. If the Lock aspect ratio check box is selected, the Height and

Width settings change in relation to one another.



Enter the width you want for the selected object. The Height and Width settings are always the dimensions of an
unrotated object. Alternatively, you can adjust the width as a percentage of the original size by entering a
percentage in the Width box under Scale. If the Lock aspect ratio check box is selected, the Height and Width

settings change in relation to one another.



Enter the height you want for the selected object as a percentage of the original size. The Height and Width
settings are always the dimensions of an unrotated object. Alternatively, you can adjust the height by entering an
exact measurement in the Height box under Size and rotate. If the Lock aspect ratio check box is selected, the
Height and Width settings change in relation to one another.



Enter the width you want for the selected object as a percentage of the original size. The Height and Width
settings are always the dimensions of an unrotated object. Alternatively, you can adjust the width by entering an
exact measurement in the Width box under Size and rotate. If the Lock aspect ratio check box is selected, the
Height and Width settings change in relation to one another.



Enter the amount, in degrees (from 0 [zero] to 359), by which you want to rotate the selected AutoShape in the
clockwise direction. The Height and Width settings are always the dimensions of an unrotated object.



Constrains the height and width of the selected object so they stay in their original proportion to one another. If
you change the height of the object, the width changes in relation to the original aspect ratio, and vice versa.



Calculates the height and width percentages under Scale, based on the original size of the picture. This option is
available only when the selected object is a picture.

In PowerPoint, if you select this check box, click the resolution of your slide show monitor in the Resolution box.



Automatically adjusts the size of the selected picture to the ideal size for viewing in a slide show. If you select this
check box, click the resolution of your slide show monitor in the Resolution box. This check box is available only
when the selected object is a picture.



Click the resolution of your slide show monitor. PowerPoint automatically calculates the best picture size for the
monitor you will use for the slide show. This option is available only when the Best scale for slide show check
box is selected.



This is the original size of the selected picture. The settings under Original size are available only when the
current selection is a picture.



Returns the selected picture to its original size. This button is available only when the current selection is a
picture.



Enter the amount you want to trim off the left side of the selected picture. Enter a negative number to add white
space to the left side. All the settings under Crop from are relative to an unscaled picture.



Enter the amount you want to trim off the top of the selected picture. Enter a negative number to add white space
to the top of the picture. All the settings under Crop from are relative to an unscaled picture.



Enter the amount you want to trim off the right side of the selected picture. Enter a negative number to add white
space to the right side. All the settings under Crop from are relative to an unscaled picture.



Enter the amount you want to trim off the bottom of the selected picture. Enter a negative number to add white
space to the bottom of the picture. All the settings under Crop from are relative to an unscaled picture.



Click Automatic to use the picture's original colors. Click Grayscale to convert a color picture to black and white.
Each color converts to an equivalent grayscale level. Click Black & White to convert the picture to pure black
and white (also known as line art). Click Watermark to format the picture with preset brightness and contrast
settings that work well for watermarks.



Drag the slider to set the contrast (saturation or intensity) of the color or enter a percentage in the % box. The
higher the percentage, the more intense the color. The lower the percentage, the more gray the color.



Opens the Recolor dialog box, where you can change the colors of the selected picture.



Removes cropping from the selected picture, and returns the color, brightness, and contrast to the original
settings.



In Word or Microsoft Excel, enter the amount of space you want between the left edge of the object and the left
edge of the page, margin, or column.

In PowerPoint, enter the amount of space you want between the left edge of the object and the left edge of the
slide.

Position settings are always relative to an unrotated object.



Click the point from which you want to position the left edge of the selected AutoShape.



In Word or Microsoft Excel, enter the amount of space you want between the top edge of the object and the top
of the page, margin, or column.

In PowerPoint, enter the amount of space you want between the top edge of the object and the top of the slide.

Position settings are always relative to an unrotated object.



Click the point from which you want to position the top edge of the selected object.



Click the point to which you want to anchor the text in the selected text box. This setting is relative to the text box.



Enter the amount of space you want between the left edge of the selected text box and the text inside it.



Enter the amount of space you want between the right edge of the selected text box and the text inside it.



Enter the amount of space you want between the top edge of the selected text box and the text inside it.



Enter the amount of space you want between the bottom edge of the selected text box and the text inside it.



Adjusts text to fit horizontally in the selected AutoShape.



Turns the text inside the AutoShape a quarter turn (90 degrees) to the right.



Adjusts the size of the AutoShape so it encompasses the text inside it.



Turns the text inside the AutoShape a quarter turn (90 degrees) to the right.



Shows how your document will look if you click OK.



Click the options you want for the fill color of the selected object.



Click the line color and line style options you want for the selected object.



Click the style and size you want for each end of your arrow. If you don't want arrows, click the straight line in the
Begin style and End style boxes. The options under Arrows are available only if the selected object is a line.



There are two ways to change the size of the selected object: by entering exact height and width measurements
under Size and rotate, or by entering height and width measurements as a percentage of the original size under
Scale. If the Lock aspect ratio check box is selected, the Height and Width settings change in relation to one
another.



There are two ways to change the size of the selected object: by entering exact height and width measurements
under Size and rotate, or by entering height and width measurements as a percentage of the original size under
Scale. If the Lock aspect ratio check box is selected, the Height and Width settings change in relation to one
another.



Cuts off (crops) the parts of the picture you enter. Enter negative numbers to add white space around the

selected picture. To crop a picture by using the mouse, click Crop on the Picture toolbar, and then drag a
sizing handle on the picture.



Changes the color, brightness, and contrast of the selected picture object.



In Word or Microsoft Excel, sets the horizontal and vertical position of the selected object relative to the edge of

the page, margin, or column.
In PowerPoint, sets the horizontal and vertical position of the selected object relative to the center and top left

corner of the slide.



Enter the amount of space you want between the edges of the selected text box and the text inside it.



Drag the slider to set the brightness (the amount of black or white added to the color), or enter a percentage in
the % box. The higher the percentage, the lighter — more white — the color. The lower the percentage, the
darker — more black — the color.



Applies and saves any changes you have made and then closes this dialog box.



The Cancel button closes this dialog box without saving any changes you have made. The Close button closes
this dialog box and retains the changes you made.






data marker

Abar, area, dot, slice, or other symbol in a chart that represents a single data point or value that originates from a
datasheet cell. Related data markers in a chart constitute a data series.



data label

A label that provides additional information about a data marker, which represents a single data point or value
that originates from a datasheet cell. Data labels can be applied to a single data marker, an entire data series, or
all data markers in a chart. Depending on the chart type, data labels can show values, names of data series or
categories, percentages, or a combination of these.



data series

A group of related data points plotted in a chart that originate from rows or columns on a single datasheet. Each
data series in a chart has a unique color or pattern. You can plot one or more data series in a chart. Pie charts
have only one data series.



3-D walls and floor

The areas surrounding many 3-D chart types that give dimension and boundaries to the chart. Two walls and one
floor are displayed within the plot area.



error bars

Graphic bars that express potential error (or degree of uncertainty) relative to each data marker in a series. You
can add y error bars to data series in 2-D area, bar, column, line, xy (scatter), and bubble charts. XY and bubble
charts can also display x error bars. Error bars can be selected and formatted as a group.



legend

A box that identifies the patterns or colors assigned to the data series or categories in a chart.



gridlines in charts

Lines you can add to a chart that make it easier to view and evaluate data. Gridlines extend from the tick marks
on an axis across the plot area.



tick marks and tick-mark labels

Tick marks are small lines of measurement that intersect an axis, similar to divisions on a ruler. Tick-mark labels

identify the categories, values, or series in the chart. Tick-mark labels come from cells on the datasheet used to
create the chart.



axis

Aline that borders one side of the plot area, providing a frame of reference for measurement or comparison in a
chart. For most charts, data values are plotted along the value (y) axis, which is usually vertical, and categories
are plotted along the category (x) axis, which is usually horizontal.



titles in charts

Descriptive text that is automatically aligned to an axis or centered at the top of a chart.



plot area

In a 2-D chart, the area bounded by the axes and including all data series. In a 3-D chart, the area bounded by
the axes and including data series, category names, tick-mark labels, and axis titles.



chart area

The entire chart and all its elements.






Enter the path or Internet address to the file you want to create a link to.



Shows lists of files you can create a hyperlink to.



You can create a hyperlink to a part of a file by using a named location, such as a bookmark in Word, a named
cell in Microsoft Excel, or a named object in Microsoft Access. Type the named location you want to create a
hyperlink to.



Shows named locations you can create a hyperlink to.



Shows the path for the selected hyperlink.



This icon represents a hyperlink to a file.



This icon represents a hyperlink to a named location in a file.



Removes the selected hyperlink.



Bases the hyperlink on the location of the current file that contains the hyperlink and not the absolute path. Use
this option to create hyperlinks to files you may want to move later. Clear this check box to use the absolute path
for the hyperlink, for example, "c:\Mydocs\Microsoft.doc".



Shows the base address for all relative hyperlinks from this document. To change the base, click Properties on
the File menu, click the Summary tab in the Properties Dialog, and type a path in the Hyperlink base box.






Click the down arrow to select from the most recently used addresses, or type the Internet address you want to
go to — for example, http://www.microsoft.com/



Opens the file in a separate window.



Lists files you can select from.



This icon represents Internet file types.






Makes the active page the World Wide Web search page, so when you click Open Search Page on the Web
toolbar, it automatically goes to this page.



Closes the dialog box.



Shows the path to the active search page.



Search page graphic.






Makes the active page the World Wide Web start page, so when you click the Home Page button, it
automatically goes to this page.



Closes the dialog box.



Shows the path of the active start page or home page.



Start page graphic.






Click the design you want for your text effect. To change the shape later, select the text effect, and click WordArt
Shape on the WordArt toolbar.



Click the new design you want for your text effect.






Custom

Runs an add-in program or a custom macro.



Spelling (Tools menu)

Checks spelling in the active document, file, workbook, or item.



Save (File menu)

Saves the active file with its current file name, location, and file format.



Print (File menu)

Prints the active file or selected items. To select print options, on the File menu, click Print.



One Page

Scales the editing view so you can see the entire page in page layout view.



Zoom to Page Width

Reduces or enlarges how the document appears so it fits within the left and right margins.



Zoom 100%

Controls how large or small a document appears on the screen. When you change the size, it does not affect
how it prints.



Insert Table

Inserts a table at the insertion point. To create a table, drag the mouse until Word shows the number of rows and
columns you want.



Columns

Changes the number of columns in a document or a section of a document.



Insert Frame

Creates a box (or frame) around a specific area of a document so you can precisely position an item in that area.



Numbering

Adds numbers to or removes numbers from selected paragraphs.



Bullets

Adds bullets to or removes bullets from selected paragraphs.



Portrait / Landscape
To print the document so the short edge of the paper is horizontal, click Portrait.

To print the document so the long edge of the paper is horizontal, click Landscape.



Decrease Indent

Indents the selected paragraph to the previous tab stop or indents contents of selected items to the left by one
character width of the standard font.



Increase Indent

Indents the selected paragraph to the next tab stop or indents contents of selected items to the right by one
character width of the standard font.



Drawing

Shows or hides the Drawing toolbar.



Chart

Creates a chart by inserting a Microsoft Graph object.



New (File menu)

Creates a new, blank file.



Copy (Edit menu)

Copies the selection to the Clipboard.



Undo

Reverses your last action. Each click reverses one more action. The command name changes to Can't Undo if
you cannot undo the previous action.



Cut (Edit menu)

Removes the selection from the active document and places it on the Clipboard.



Paste (Edit menu)

Inserts the contents of the Clipboard at the insertion point, and replaces any selection. This command is
available only if you have cut or copied an object, text, or contents of a cell.



Open (File menu)

Opens or finds a file.



Envelope

Creates an envelope.



Zoom

Controls how large or small a document appears on the screen.



Equation Editor

Shows the Microsoft Equation Editor toolbar so you can create equations.



Pen Comment

Comments you can insert directly in the document window if your system is equipped with a pen. Word treats
pen comments like any other drawing object. Pen comments don't appear in the comments pane, and Word
doesn't insert comment marks in the document window.



Repeat

Repeats your last command or action, if possible. The Repeat command changes to Can't Repeat if you cannot
repeat the last action. When you use the Undo command to reverse an action, the Repeat command changes to
Redo. The Redo command reverses the action of the Undo command.



Microsoft Word

Starts or switches to Microsoft Word.



Find (Edit menu)

Searches selected cells or sheets for the characters you specify, and selects the first cell that contains those
characters.



Clear (Edit menu)

Deletes the selected object or text without putting it on the Clipboard. This command is available only if an object
or text is selected.



Toggle Breakpoint

Sets or removes a breakpoint at the line of code that contains the insertion point. Visual Basic enters break mode
when it encounters a breakpoint.



Single Spacing

Sets paragraph line spacing to single spacing.



1.5 Spacing

Sets paragraph line spacing to 1.5-line spacing.



Double Spacing

Sets paragraph line spacing to double spacing.



Superscript

Changes the format of the selected text to superscript.



Subscript

Changes the format of the selected text to subscript.



Double Underline

Formats the selected text with a double underline. If the selection is already double-underlined, clicking
removes the double-underlining.



Word Underline

Underlines the selected words, but doesn't underline the spaces between the words.



Grow Font

Increases the font size of selected text by 10 percent of the active setting.



ShrinkFont

Decreases the font size of selected text by 10 percent of the active setting.






Close (File menu)

Closes the active file without exiting the application. If the file contains any unsaved changes, you will be

prompted to save the file before closing. To close all open files, hold down SHIFT and click Close All on the File
menu.



AutoFormat (Table menu)

In Microsoft Word, automatically applies formats, including predefined borders and shading, to a table.
Automatically resizes a table to fit the contents of the table cells.

In Microsoft Excel, applies a built-in combination of formats to a cell range or a PivotTable. If a single cell is
selected, Microsoft Excel automatically selects the range surrounded by blank cells and applies the autoformat to
that range. If the selection is part of a PivotTable, the entire table, except for the page fields, is selected and
formatted. This command is not available if the sheet is protected.



Format Painter (Standard toolbar)
Copies the format from a selected object or text and applies it to the object or text you click. To copy the

formatting to more than one item, double-click , and then click each item you want to format. When you are
finished, press ESC or click

again to turn off the Format Painter.



Print Preview (File menu)

Shows how a file will look when you print it.



Pick Up Object Style

i,
Copies object attributes such as font, color, and size so they can be applied to other objects by clicking
Apply Object Style. This command is not available in slide sorter view or if no text is selected. You can apply

these attributes by clicking

until you pick up a different style.



Apply Object Style

A
Applies the attributes you picked up by using the Pick Up Object Style command. You can apply these
attributes by clicking

until you pick up a different style.



Bold (Formatting toolbar)

Makes selected text and numbers bold. If the selection is already bold, clicking removes bold formatting.



Italic (Formatting toolbar)

Makes selected text and numbers italic. If the selection is already italic, clicking removes italic formatting.



Underline (Formatting toolbar)

Underlines selected text and numbers. If the selection is already underlined, clicking @ removes underlining.



Borders

Adds a border to the selected cell or range. To format a cell or range with the last selected border, click the
button. To specify another type of border, click the arrow next to the button, and then select a border style from

the palette.



Bottom Border

Adds or removes a border along the lower edge of the selection.



Dark Shading

Applies a dark shading pattern to selected cells and graphic objects, but not to their borders.



Show All

Displays nonprinting characters such as tab characters, paragraph marks, and hidden text.



Align Left (Formatting toolbar)

Aligns the selected text, numbers, or inline objects to the left with a ragged right edge.



Align Right (Formatting toolbar)

Aligns the selected text, numbers, or inline objects to the right with a ragged left edge.



Center (Formatting toolbar)

Centers the selected text, numbers, or inline objects.



Justify (Formatting toolbar)

In Microsoft Word, aligns the selected paragraphs to both the left and right margins or indents.

In Microsoft Excel, breaks the cell contents into multiple lines within the cell and adjusts the spacing between
words so that all lines are as wide as the cell.



Date (Header and Footer toolbar)

Inserts a date field that automatically updates so that the current date is displayed when you open or print the
file.



Time (Header and Footer toolbar)

Inserts a time field that automatically updates so that the current time is displayed when you open or print the file.



Page Numbers (Header and Footer toolbar)

Inserts page numbers that automatically update when you add or delete pages.



Undo (Edit menu)
Reverses the last command or deletes the last entry you typed. To reverse more than one action at a time, click

the arrow next to , and then click the actions you want to undo. The command name changes to Can't
Undo if you cannot reverse the last action.



Redo

Reverses the action of the Undo command. To redo more than one action at a time, click the arrow next to ,
and then click the actions you want to redo.



Line (Drawing toolbar)

Draws a straight line where you click or drag in the active window. To constrain the line to draw at 15-degree
angles from its starting point, hold down SHIFT as you drag.



Rectangle (Drawing toolbar)

Draws a rectangle where you click or drag in the active window. To draw a square, hold down SHIFT while you
drag.



Promote (Outlining toolbar)

Moves the selected paragraph to the next-higher heading level (up one level, to the left).



Demote (Outlining toolbar)

Moves the selected paragraph to the next-lower heading level (down one level, to the right).



Move Up (Outlining toolbar)

Moves a selected paragraph and its collapsed (temporarily hidden) subordinate text up, above the preceding
displayed paragraph.



Move Down (Outlining toolbar)

Moves a selected paragraph and its collapsed (temporarily hidden) subordinate text down, below the following
displayed paragraph.



Demote to Body Text (Outlining toolbar)

Changes a selected heading to body text and applies the Normal style.



Expand (Outlining toolbar)

In Word, displays collapsed subheadings and body text of a selected heading, one level at a time. In PowerPoint,
displays the titles and all collapsed text of selected slides.



Collapse (Outlining toolbar)

In Word, hides body text and subheadings of a selected heading, one level at a time. In PowerPoint, hides all but
the title of selected slides. Collapsed text is represented by a gray line.



Text Box

Draws a text box where you click or drag in the active window. Use a text box to add text — such as captions or
callouts — to your pictures or graphics.



Find File

Finds files based on the search criteria you enter.



Find (Edit menu)

Searches for specified text, formatting, symbols, comments, footnotes, or endnotes in the active document.



Insert Microsoft Excel Spreadsheet

Inserts a new Microsoft Excel worksheet at the insertion point. Drag to select the number of rows and columns.



Page Break (Insert menu)

Inserts a page break at the insertion point.



AutoFormat (Format menu)

Analyzes the content of the active file and then automatically formats the file. If you want to change the automatic
formattintions before autoformatting begins, use the AutoFormat command (Format menu) instead of

clicking .



Top Border

Adds or removes a border from the top edge of selected text, paragraphs, cells, pictures, or other object.



Bottom Border

Adds or removes a border from the bottom edge of selected text, paragraphs, cells, pictures, or other object.



Left Border

Adds or removes a border from the left edge of selected text, paragraphs, cells, pictures, or other object.



Right Border

Adds or removes a border from the right edge of selected text, paragraphs, cells, pictures, or other object.



Apply Inside Borders / Inside Borders

Adds or removes a border between selected paragraphs or cells. This command has no effect on selected text or
if the selection is a single paragraph.



Clear Border / No Border

Removes borders from selected text, paragraphs, cells, pictures, or other object.



Oval

Draws an oval where you click or drag in the active window. To draw a circle, hold down SHIFT while you drag.



Arc

Draws an arc where you click or drag in the active window. To define the shape within a perfect square, hold
down SHIFT while you drag.



First Record
Displays the main document merged with information from the first data record selected for merging. Word

o
displays merged data only if View Merged Data Lf#%| is pressed in.



Previous Record
Displays the main document merged with information from the previous data record. Word displays merged data

'y
only if View Merged Data is pressed in.



Next Record

Displays the main document merged with information from the next data record selected for merging. Word

'y
displays merged data only if View Merged Data is pressed in.



Last Record

Displays the main document merged with information from the last data record selected for merging. Word

'y
displays merged data only if View Merged Data is pressed in.



Insert Merge Field

Inserts instructions that identify the information Word will insert from the selected data source.

For more information, click .



Merge to New Document

Runs the mail merge and places the results in a single, new document.



Merge to Printer

Runs the mail merge and prints the results.



Check for Errors

Reports errors in the main document or the data source that prevent merging. You can fix the errors before you
run the mail merge.



Data Form

Opens the Data Form dialog box, where you can view and edit your mail merge data, one record at a time.



View Merged Data

Displays the main document merged with information from the selected data records. To view a specific record,
enter the record number in the Go to record box, or click one of these buttons to find the data record: First

Record IEI Previous Record

EI, Next Record

, or Last Record



Group

Assembles two or more selected objects into a single object so they can be moved or changed as a group.



Ungroup

Disassembles a grouped object into individual objects so each can be moved or changed individually.



Order Bring to Front (Draw menu)

Places the selected object in front of other overlapping objects.



Order Send to Back (Draw menu)

Places the selected object behind other overlapping objects.



Order Bring in Front of Text (Draw menu)

Places the selected drawing object in front of text.



Order Send Behind Text (Draw menu)

Places the selected drawing object behind text.



Order Bring Forward (Draw menu)

Moves the selected object or group one step closer to the top of a stack of objects.



Order Send Backward (Draw menu)

Moves the selected object or group one step closer to the bottom of a stack of objects.



Magnifier

Magnifies a document in print preview for easier reading. Click and then, when the mouse pointer
changes to a magnifying glass, click the document to zoom in or out. Magnifying a page does not affect printing
size.



Shrink to Fit

Reduce the number of pages in a document by one so that you can prevent a small portion of a document from
spilling onto another page.



Many Pages

Displays two or more pages on the screen in print preview or page layout view. Click , and then drag to
select the number of pages you want to display. In Microsoft Outlook this displays the pages that will be printed.



Full Screen (View menu)

Hides most screen elements so that you can view more of your document. To switch back to your previous view,

click or press ESC.



Ruler (View menu)

Displays or hides the horizontal ruler, which you can use to position objects, change paragraph indents, page
margins, and other spacing settings.



Rounded Rectangle

Draws a rectangle with rounded corners where you click or drag in the active window. To draw a square, hold
down SHIFT while you drag.



Voice Comment

Records a voice comment at the insertion point. Click , and then record the comment. To record voice
comments, you must have a microphone. To listen to voice comments, you must have a sound board installed in
your computer.



Select Objects

Changes the pointer to a selection arrow so you can select objects in the active window. To select a single object,
click the object with the arrow. To select one or more objects, drag the arrow over the objects you want to select.



Find Record

Searches for specific data records within a selected field.



Macros Record New Macro (Tools menu)

Records a series of actions as a macro that you can later "play back."



Pause / Resume Recording

Suspends or resumes recording a macro. The macro recorder doesn't record actions you take while recording is
suspended.



Macro Macros (Tools menu)

Opens the Macros dialog box, where you can run, edit, or delete a macro. Use Record New Macro EI to
record a series of actions as a macro, or click Visual Basic Editor

to write a macro.



Trace

For Visual Basic procedures, clicking this button puts Visual Basic into break mode and opens the Debug
window. For Microsoft Excel version 4.0 macros, clicking this button allows you to step through the currently
selected macro one cell at a time, starting at the active cell.



Step In

Runs the next executable line of code in the active Visual Basic procedure (the line with a rectangle around it),
stepping into other Visual Basic procedures when they're called. If the called procedure is in a hidden module,
the Step Into button acts like the Step Over button.



Resume Macro

Continues running the active macro from the current instruction. This button is available only when it appears
pressed in — that is, when Visual Basic is in break mode, or when a Microsoft Excel version 4.0 macro is
paused.



Dialog Editor

Runs or switches to Microsoft Dialog Editor.



REM

Adds or removes REM (Remark) statements at the beginning of the selected lines in a macro-editing window.
When a macro runs, Word ignores lines that begin with a REM statement.



Record Next Command

Records the next command you choose. Word inserts the corresponding WordBasic instruction at the insertion
point in the active macro-editing window.



Step Over

Runs the next executable line of code in the active Visual Basic procedure (the line with a rectangle around it),

running other Visual Basic procedures when they're called without stepping into them. This button is available
only in break mode.



Flip Horizontal

Flips the selected drawing object horizontally 180 degrees. This command is not available if the selected object
cannot be rotated — a picture or an OLE object, for example.



Flip Vertical

Flips the selected drawing object or group vertically 180 degrees, that is, from top to bottom. This command is
not available if the selected object cannot be rotated — a picture or an OLE object, for example.



Rotate Right

Rotates the selected drawing object 90 degrees to the right. This command is not available if the selected object
cannot be rotated — a picture or an OLE object, for example.



Rotate Left

Rotates the selected object 90 degrees to the left. This command is not available if the selected object cannot be
rotated — a picture or an OLE object, for example.






Freeform

Draws an object with both curved and straight segments. Drag to draw freehand shapes; click and move the
mouse to draw straight lines. To end a shape and leave it open, double-click it at any point. To close a shape,
click near its starting point.



Callout

Draws a callout where you click or drag in the active window.



Magnified f

A custom button image that you can assign a command, macro, or AutoText entry to.



Borders

Adds a border to the selected cell or range.

To format a cell or range with the last selected border, click . To specify another type of border, click the
arrow next to the button, and select a border style from the palette.



Drawing

Displays or hides the Drawing toolbar.



AutoText (Insert menu)

Creates or inserts an AutoText entry.



Edit Points (Draw menu)

Displays the vertices so you can change the shape of the selected freeform drawing object or curve. To reshape
the freeform, drag one of the vertices that form its outline. To add a vertex to the freeform, click where you want
to add it, and then drag. To delete a vertex, press CTRL and click the vertex you want to delete.



Callout Options

Formats the selected callout.



Sort Ascending

Sorts the selected items in order from the beginning of the alphabet, the lowest number, or the earliest date,
using the column that contains the insertion point. If you previously set other sorting options, those options are
still in effect.



Sort Descending

Sorts the selected items in order from the end of the alphabet, the highest number, or the latest date, using the
column that contains the insertion point. If you previously set other sorting options, those options are still in
effect.



Design Mode

Switches to forms design mode, where you can edit or create a form by using the ActiveX tools on the Control
Toolbox. This button changes to Exit Design Mode while you are in forms design mode.



Add Record

Inserts a blank form for a new record at the bottom of the table.



Delete Record

Deletes the record that contains the insertion point.



Update Fields

Updates the records in the selected database field. This button is available only if you've selected the Insert data
as field check box in the Insert Data dialog box.



Database

Inserts information from a database or other data source as a table in your document.



Grid (Draw menu)

Sets the snap-to-grid options that you can use to easily align drawing objects.



Create Picture

Opens a separate window in which you can create a picture. Also displays the Edit Picture toolbar. When you
finish editing the picture, click Close Picture to return to your Word document.



Text Form Field (Forms toolbar)

Inserts a text form field where you click or drag in the active file.



Check Box (Forms toolbar)

Inserts a check box form field where you click or drag in the active file.



Combo Box (Forms toolbar)

Creates a combination drop-down list box and edit box where you click or drag in the active file.



Properties

Changes the properties of the ActiveX controls in the file, or changes the options for the selected form field.



Form Field Shading

Displays or hides the gray shading on form fields.



Normal (View menu)

Switches to normal view, which is the default document view for most word-processing tasks, such as typing,
editing, and formatting.



Lock Cell (Microsoft Excel)

Prevents selected cells from being changed, moved, resized, or deleted. Locking cells has no effect unless the
sheet is protected.

Protect Form (Microsoft Word)

Protects the current document from changes except in form fields or unprotected sections. To apply or remove
protection from individual sections, click Protect Document on the Tools menu, click Forms, and then click
Sections.



AutoSum

In Microsoft Excel, adds numbers automatically with the SUM function. Microsoft Excel suggests the range of
cells to be added. If the suggested range is incorrect, drag through the range you want, and then press ENTER.

In Word, inserts an = (Formula) field that calculates and displays the sum of the values in table cells above or to
the left of the cell containing the insertion point.



Stop Recording

Stops running or recording a macro.



Watch

Displays the value of the selected Visual Basic expression in the Instant Watch dialog box. You can add this
expression to the list of watch expressions in the Instant Watch dialog box.



Master Document (View menu)

Switches back and forth between outline view and master document view, and also displays the Master
Document and Outlining toolbars.



Create Subdocument

Converts the selected text in a master document into subdocuments, based on the first selected heading style.



Remove Subdocument

Converts a subdocument to text within a master document, breaking the link between the master document and
the file that contained the subdocument.



Insert Subdocument

Inserts an existing document into a master document as a subdocument.



Split Subdocument

Splits an existing subdocument into two subdocuments. The document is split at the insertion point.



Merge Subdocument

Converts two adjacent, selected subdocuments into a single subdocument. When you save the master
document, the merged subdocuments are saved in the file that contained the first subdocument.



Lock Document

Locks a subdocument so that no changes can be made. To unlock the document, click again.



Switch Between Header and Footer

Moves the insertion point between the areas in which you create or change headers and footers.



Previous Header

Moves the insertion point to the previous header or footer.



Next Header

Moves the insertion point to the next header or footer.



New Header

Inserts a header.



Delete Header

Deletes the header in the active file.



Align

Aligns selected drawing objects with one another or with the page.



Arrow

Inserts a line with an arrowhead where you click or drag in the active window. To constrain the line to draw at 15-
degree angles from its starting point, hold down SHIFT as you drag.



Main Document

Switches to the main document that is associated with this mail merge data source.



Merge Options

Opens the Mail Merge dialog box, where you can set options for the current mail merge.



Mail Merge (Tools menu)

Produces form letters, mailing labels, envelopes, catalogs, and other types of merged documents.



Page Setup (File menu)

Sets margins, paper source, paper size, page orientation, and other layout options for the active file.



Show/Hide Document Text

Displays or hides the document text while you work in the header or footer area.



Same as Previous

Inserts the header or footer from the previous section in the current section, or creates a different header or
footer by breaking the header or footer connection between the two sections.



Show First Line Only

Hides all but the first line in each paragraph of body text in your outline. An ellipsis (...) indicates that additional
lines are hidden.



Show Formatting

Shows or hides character formatting (such as bold and italic) in outline view. In slide sorter view, switches
between showing all text and graphics on each slide and displaying titles only.



Font (Format menu)

Changes the font and character spacing formats of the selected text.



Style (Format menu)

Defines or applies to the selection a combination of formats, called a style.



Font Size

Changes the size of the selected text and numbers. In the Font Size box, enter a size. The sizes in the Font
Size box depend on the selected font and active printer.



Borders

Opens the Borders and Shading dialog box (Format menu), where you can add or modify borders and shading
on selected paragraphs, text, cells, pictures, and other objects.



Shading

Opens the Borders and Shading dialog box (Format menu), where you can add or modify borders and shading
on selected paragraphs, text, cells, pictures, and other objects.



Send

Sends the active file as an attachment to an electronic mail message.



Add Routing Slip

Sends the active file to reviewers to change and add comments. To use routing, you and those you are sending

the document to must have installed both the application in which the document was created and Microsoft
Exchange or a compatible mail package.

When you have an existing routing slip or a message has been sent to you with a routing slip, the command
name changes to Edit Routing Slip.



Footnote (Insert menu)

Inserts a footnote or endnote at the insertion point. You can also specify the type of note reference mark and how
Word numbers, formats, and positions notes.



WordArt Gallery
Creates text effects by inserting a Microsoft WordArt object.



Microsoft Mail

Starts Microsoft Mail or switches to it if it is already running.



Microsoft Excel

Starts Microsoft Excel or switches to it if it is already running.



Microsoft Access

Starts Microsoft Access or switches to it if it is already running.



Microsoft Schedule+

Starts Microsoft Schedule+ or switches to it if it is already running.



Microsoft Visual FoxPro

Starts Microsoft Visual FoxPro or switches to it if it is already running.



Microsoft PowerPoint

Starts Microsoft PowerPoint or switches to it if it is already running.



Microsoft Publisher

Starts Microsoft Publisher or switches to it if it is already running.



Microsoft Project

Starts Microsoft Project or switches to it if it is already running.



From Disk

A custom button image that you can assign a command, macro, or AutoText entry to.



To Disk

A custom button image that you can assign a command, macro, or AutoText entry to.



Musical Note

A custom button image that you can assign a command, macro, or AutoText entry to.



Bell

A custom button image that you can assign a command, macro, or AutoText entry to.



Speech Balloon

A custom button image that you can assign a command, macro, or AutoText entry to.



Telephone

A custom button image that you can assign a command, macro, or AutoText entry to.



Sad Face

A custom button image that you can assign a command, macro, or AutoText entry to.



Key

A custom button image that you can assign a command, macro, or AutoText entry to.



Big Notebook

A custom button image that you can assign a command, macro, or AutoText entry to.



Pushpin

A custom button image that you can assign a command, macro, or AutoText entry to.



Camera

Takes a picture of the current selection and pastes it in a new location. Click to take the picture, and then
click where you want to paste the upper-left corner of the selection.



Video Camera

A custom button image that you can assign a command, macro, or AutoText entry to.



Button

A custom button image that you can assign a command, macro, or AutoText entry to.



Calculator

Opens Calculator, an accessory program you can use to perform simple calculations in standard or scientific
notation. You can also assign a command, macro, or AutoText entry to the Calculator button.



Microsoft Bookshelf

Starts Microsoft Bookshelf or switches to it if it is already running.



Solitaire

Opens Solitaire, an accessory program. You can also assign a command, macro, or AutoText entry to the
Solitaire button.



Page Layout/Page Break Preview (View menu)

Switches the active document to page layout or page break preview, which is an editing view that displays your
document as it will print. Page layout view uses more system memory, so scrolling may be slower, especially if
your document contains many pictures or complex formatting.



View Field Codes

Displays or hides field codes.



Drop Cap

Formats a letter, word, or selected text with a large initial — or "dropped" — capital letter. A "drop cap" is
traditionally the first letter in a paragraph, and it can appear either in the left margin or dropped from the base line
of the first line in the paragraph.



Strikethrough

Draws a line through the selected text. If the selection already contains strikethrough formatting, clicking
removes the formatting.



Small Caps

Formats selected lowercase text as capital letters and reduces their size. Small caps formatting does not affect
numbers, punctuation, nonhabetic characters, or uppercase letters. If the selection already contains SMALL

CAPs formatting, clicking removes the formatting.



Delete Cells

Deletes the selected cells or the cell that contains the insertion point. If you select an entire row or column, the
command changes to Delete Rows or Delete Columns, respectively.



Delete Rows

Deletes the selected cells or the cell that contains the insertion point. If you select an entire row or column, the
command changes to Delete Rows or Delete Columns, respectively.



Delete Columns

Deletes the selected cells or the cell that contains the insertion point. If you select an entire row or column, the
command changes to Delete Rows or Delete Columns, respectively.



Insert Cells

Inserts the number of cells, rows, or columns you select. In Word, this command is available only when you've
selected one or more end-of-cell marks.



Insert Rows

Inserts the number of cells, rows, or columns you select. In Word, this command is available only when you've
selected one or more end-of-cell marks.



Insert Columns (Table command)

Inserts the number of cells, rows, or columns you select. In Word, this command is available only when you've
selected one or more end-of-cell marks.



Arrange (Window menu)

Displays all open files in separate windows on the screen. The Arrange command makes it easier to drag
between files.






Gridlines (Table menu)

Displays or hides dotted gridlines to help you see which cell you're working in. Table gridlines don't print; if you
want to add printable gridlines to your table, use the Borders and Shading command (Format menu).



Open Subdocument

Opens a subdocument of a master document.



Split (Window menu)

Splits the active window into panes, or removes the split from the active window.



New Window (Window menu)

Opens a new window with the same contents as the active window so you can view different parts of a file at the
same time.



Track Changes Compare Documents (Tools menu)

Compares an open, edited document with the original document, and marks any differences in the edited
document.



Track Changes Accept or Reject Changes (Tools menu)

Finds and selects each tracked change in a document so that you can review, accept, or reject the change.



All Caps

Formats selected lowercase text as all capital letters. Formatting text as all capital letters does not affect
numbers, punctuation, nonalphabetic characters, or uppercase letters. If the selection is already formatted as all

capital letters, click 22| to remove the formatting.



Disassemble Picture

Separates the selected metafile picture into distinct drawing objects.



Symbol (Insert menu)

Inserts symbols and special characters from the fonts that are installed on your computer.



Change Case (Format menu)

Changes the capitalization of selected text.



Shrink Font 1 Pt

Decreases the font size of selected text by one point.



Grow Font 1 Pt

Increases the font size of selected text by one point.



Repaginate

Repaginates the active document. Word repaginates documents automatically if the Background repagination
check box is selected (Tools menu, Options command, General tab).



Replace

Searches for and replaces specified text, formatting, footnotes, endnotes, or comment marks in the active
document.



Start of Line

Moves the insertion point to the beginning of the current line.



End of Line

Moves the insertion point to the end of the current line.



Page Up

Moves the insertion point and document display to the previous screen of text.



Page Down

Moves the insertion point and document display to the next screen of text.



Vertical Textbox

Draw a text box where you click or drag so you can add text to a graphic.



Start of Document

Moves the insertion point to the beginning of the first line of the document.



End of Document

Moves the insertion point to the end of the last line of the document.



Send Mail

Sends the message or file.



Reply

Returns a message or file to the sender.



Reply to All

Returns the message or file to the sender and everyone who is on the To or Cc line.



Forward

Sends the message or file to the recipient you specify.



Not Applicable

A custom button image that you can assign a command, macro, or AutoText entry to.



Close, Close All (File menu)

Closes the active file without exiting the application, prompting you to save if the file contains unsaved changes.
To close all open files, hold down SHIFT and click Close All on the File menu.



Convert Text to Table, Convert Table to Text (Table menu)

Converts selected text to a table, or converts the selected table to delimited text. Text you convert to a table must
include separator characters, such as tab characters or commas.



Insert Table (Table menu)

Inserts a table with the number of rows and columns you specify. This command changes to Insert Columns
, Insert Cells

B or Insert Rows
=
=" when the insertion point is in a table, depending on what is currently selected.



Delete Cells/Rows/Columns (Table menu)

Deletes the selected cells or the cell that contains the insertion point. If you select an entire row or column, the
command changes to Delete Rows or Delete Columns, respectively.



Repeat (Edit menu)

Repeats your last command or action, if possible. The Repeat command changes to Can't Repeat if you cannot
repeat the last action.

When you use the Undo command to reverse an action, the Repeat command changes to Redo. The Redo
command reverses the action of the Undo command.



Protect Document, Unprotect Document (Tools menu)

Prevents changes to all or part of an online form or document except as specified. You can also assign a
password so that other users can annotate a document, mark revisions, or fill in parts of an online form. When a
document is protected, this command changes to Unprotect Document.



Frame (Insert menu)

Creates a box, or frame, around a specific area of a document so that you can precisely position an item in that
area. To change a frame, click Frame on the Format menu.



Regroup

Reassembles a group of objects that have been disassembled using the Ungroup command.



3-D

Adds a three-dimensional effect to the selected object.



Highlight

Marks text so it is highlighted and stands out from the surrounding text. Click , and then select the text or
object you want to highlight. When you are done highlighting, click

again. To change the highlight color, click the arrow next to
, and then click the color you want.



Address Book (Tools menu)

Displays a list of e-mail addresses.



Reply (Compose menu)

Returns a message or file to the sender.



Reply to All (Compose menu)

Returns the message or file to the sender and everyone who is on the To or Cc line.



Forward

Sends the message or file to the recipient you specify.



Move Mail

Moves the selected messages to the folder you specify.



Delete Mail

Delete the selected message.



Previous

Shows the previous item.



Next

Shows the next item.



Check Names (Tools menu)

Checks the names in the To, Cc, or Bcc boxes agains